
Chapter 4 - New Features
Visual 2.7 incorporates new features to increase productivity and allow for easier use with the most complex models:

The Sidebar provides convenient access to three tabs of information that also allow for the modification of model object parameters and the display of calculation results.

The Layers tab is located in the Sidebar and contains the Layer Manager. The Layer Manager shows System Layers and user-defined Layers and allows control of Layer
behavior to provide lighting model organization based on what is appropriate for a project or useful for a user.

The Design Manager provides quick access to all objects in the lighting model in a floating dialog window. The dialog lists all objects in a treed fashion based on object type. Objects can
be selected and identified or modified.

An Audit is performed before each Calculation and provides feedback related to known and possible problems with the lighting model. Audits can be done at any point to verify model
components. The Audit window dialog sits on top of the Design Environment.

The Properties tab is located in the Sidebar. The tab is dynamic in that the content will change depending on which of the four object types is chosen in the selection process.

Several videos have been produced to illustrate features. The currently available videos can be found at:

http://www.visual-3d.com/support/TrainingVideos/2012.aspx
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4.1 Audit
The Audit command is located on the File menu. An Audit is performed before each Calculation and provides feedback related to known and possible problems with the lighting model. Audit
results do not preclude a calculation from being performed; results are an alert that the calculation result may not be what was expected.

An Audit can be performed without a calculation by executing the command from the
File menu.

 

If Visual finds no issues, a pop-up is displayed.  

If issues are found, Visual displays a notification bar at the top of the Design
Window. Clicking the View Audit Results button initiates the Audit Results
dialog. Clicking an entry will highlight the objects related to the issue in the Design
Environment.

 

To identify an element in the Audit, left-click the name of an object. Visual will
highlight the object in red in the Design Environment, just as in any other selection
process.

The Properties tab of the Sidebar will be populated with the parameters for the
selected object for verification or modification.

The Audit Results dialog is closed by clicking the "X" in the upper right corner of the
dialog.

 

Visual provides different symbols for the various issues that can be analyzed.  

Possible Problem issues:

Audit Message Description
Luminous Dimensions Conflict A luminaire symbol and its luminous dimensions are different
Luminaires Intersect Multiple luminaires are detected to overlap
Luminaire Intersects a Surface A luminaire intersects a surface
Incorrect Luminaire Mounting A luminaire has luminous surfaces on or behind the mounting surface

javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_1_Visual_Interface/Design_Environment/1.1.8_Sidebar.htm
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


Possible Information issues:

Audit Message Description
Invisible Objects Objects that participate in the lighting calculation are on invisible layers
Objects Intersect A closed room or object intersects or overlaps another closed room or object
Luminaire Outside Project Extents A luminaire may be outside of the project extents
Calculation Zone Not Illuminated A calculation zone is inside an unilluminated closed room or object
Surfaces Intersect A surface is intersecting another surface
Identical Surface A surface is identical to another surface

Possible Critical issues:

Audit Message Description
Duplicate Luminaires Multiple luminaires are detected at the same location
Large Drawing Coordinates Drawing coordinates are too large to perform a calculation. Move the entire drawing closer to 0,0.

The Audit tool does not ensure that the lighting model is free of errors or that the resultant calculation is "correct" given the many possible intents of user input. It is ultimately the responsibility of
the user to ensure the lighting model approximates reality in an appropriate way.

javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


4.2 Design Manager
The Design Manager provides quick access to all objects in the lighting model in a floating dialog.

The Design Manager is opened by clicking the button in the Tools panel of the
Home tab of the Ribbonbar the button in the Windows sub-menu of the Tools
tab.

 

The Design Manager dialog is always on top of the Design Environment
window and can be repositioned with a left-click-drag motion of the title bar as with all
Windows applications.

The number after each main entry is the quantity of that type currently placed in the
model.

Each section (branch of the tree structure) is opened and closed by either double-
left-clicking the branch names or clicking the "+" and "-" buttons.

The Design Manager is closed by clicking the "X" in the upper right corner of the
dialog.

 

To identify an element in the model, left-click the name of an object. Visual will
highlight the object in red in the Design Environment, just as in any other
selection process.

The Properties tab of the Sidebar will be populated with the parameters for the
selected object for verification or modification.

 

Clicking a Calculation Zone name will highlight the zone in the Design
Environment.
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Power Zones involve both luminaire and an attributed area, so both are included.
This allows for easy verification of the luminaires included in a Power Zone
calculation. Clicking the zone name highlights the attributed area in the Design
Environment. Clicking the Luminaire name highlights the Luminaire in
the Design Environment.

 

The Luminaires section includes all Luminaires placed in the Design
Environment. Clicking a Luminaire name highlights the Luminaire in
the Design Environment.

 

The Luminaire Types section shows all Luminaires defined in the Luminaire
Schedule and the sub-branch shows each Luminaire placed in the Design
Environment. This provides the same functionality as the Luminaires branch but
with different organization. Clicking a Luminaire Type name has no function.
Clicking a Luminaire name highlights the Luminaire in the Design
Environment.

 

Solids are grouped in the Design Manager if they are grouped in the Design
Environment; i.e. Rooms and Structures will be shown by the names given to
them upon creation and Solids will be shown below that object name.

Clicking a Solid name highlights that Solid in the Design Environment.

Individually created Solids will be shown without a Collapse/Expand button since
it is a single entity and has no sub-branches in the tree; e.g. "Divider" shown at right.

The number of Solids in each Group is shown after the Group name.

 

Since Background objects are for reference, they are not displayed in the Design Manager.
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4.3 Layers
Layers can be used for complex projects to organize as well as control display and calculatability.

All Visual models have the default System Layers Group in the Layer Manager
and therefore in the model. The Group and its associated Object Layers cannot be
deleted.  A complete and complex model can be constructed without using Layers;
Visual uses Layers as necessary in a transparent fashion if the user doesn't need or
want to use the feature.

 

Layers are controlled in the Layer Manager discussed in this section.
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4.3.1 Calcula on State
The Layer Calculation State is controlled in the Layer Manager found in the Layers tab of the Sidebar.

The Calculation State button controls whether or not objects associated to that
Group or Layer are included in calculations.

The Calculation State button has different states than can be assigned and
therefore different symbols will appear indicating the different states. The position of
the Calculation State button remains constant.

 

The default state for all Layers is Calculated. This means objects on that Layer will
be included in calculations.

 

The Inactive state tells Visual to not include objects associated to that Layer or
Group when performing calculations.

 

The default state for all Groups is By Layer. This means that the Calculation
State for each Layer in the Group is set individually.

 

Choosing an Calculation State at the Group level means that all Layers in that
Group will have the same state.

Individual Layer Calculation State cannot be modified in this case, which Visual
indicates with lock symbols on top of each Layer Calculation State button.

To modify Layer Calculation in this situation, set the Group Calculation State to
By Layer, and then modify the Layer Calculation State(s) as desired.

 

There are two methods for changing Calculation State:

Left-clicking the Calculation State button will change to the next state type.
Continually left-clicking will cycle through the four Calculation States.

Note that By Layer is not a valid state for Layers; it only applies to Groups.

 

Alternately, right-clicking the Calculation State button for a Layer or Group will
pop-up a menu showing the three states and a choice can be made by left-clicking the
desired state.
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The ability to control the Calculation State for Background objects is included for completeness. It is of course the case that Background objects do not contribute to calculations.



4.3.2 Colors
Layer Colors are controlled in the Layer Manager located in the Layers tab of the Sidebar.

The Color of each Group or Layer is controlled with the Color button.

The Color button has different states than can be assigned and therefore different
symbols will appear indicating the different states. The position of the Color button
remains constant.

Clicking the Color button opens the Color Dialog for selection. See Using the Color
Dialog for more information.

 

The default state of the Color button for  all Layers is "By Entity"; Properties of
the Object control the Color.

 

Assigning a Color to a Layer will override Object Properties Color choices; the
Color of Objects will be the Color of the Layer.

 

The default state of the Color button for all Groups is "ByLayer"; each Layer has a
separate Color and can be assigned

 

The Group Color can be chosen by clicking the By Group Color button, which
opens the Color Dialog. Assigning a Group Color overrides Color selection for all
Layers and Visual will show a lock symbol on the Group member Color buttons
indicating this.

In the example at right, the Group Color is set to blue and the Color of the Layers
in the Group are locked due to that choice.

Layer Colors can be assigned (unlocked) by choosing "By Layer" as the Color for
the Group.
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4.3.3 Editability
The Layer Editability State is controlled in the Layer Manager found in the Layers tab of the Sidebar.

The Editability of each Group or Layer is controlled with the Editability State
button.

The Editability State button has different states than can be assigned and therefore
different symbols will appear indicating the different states. The position of the
Editability State button remains constant.

 

The default state for all Layers is Editable. This means objects on that Layer can
be selected and are of course visible.

 

The Uneditable state makes objects gray in color, and they cannot be selected.  

The Invisible state makes objects on that Layer Invisible.  

The By Layer state is applicable only to Groups and means that the Editability
State of Layers in the Group is set for each Layer.

 

Choosing an Editability State at the Group level means that all Layers in that
Group will have the same state.

Individual Layer Editability State cannot be modified in this case, which Visual
indicates with lock symbols on top of each Layer Editability State button.

To modify Layer Editability in this situation, set the Group Editability State to By
Layer, and then modify the Layer Editability State(s) as desired.

 

There are two methods for changing Editability State:

Left-clicking the Editability State button will change to the next state type.
Continually left-clicking will cycle through the four Editability States.

Note that By Layer is not a valid state for Layers; it only applies to Groups.

 

 

Alternately, right-clicking the Editability State button for a Layer or Group will pop-
up a menu showing the four states and a choice can be made by left-clicking the
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desired state.

 



4.3.4 Groups
Layer Groups are controlled in the Layer Manager found in the Layers tab of the Sidebar. Groups provide many ways to organize a project but the use of Groups is not required for even
complex projects.

A New Group can be created to organize Layers. The Group type can be
selected as Static or Dynamic in the Properties panel at the bottom of the
Layer Manager.

 

All Visual files contain the Dynamic System Layers Group.  

Dynamic Groups are those that have the four Object Layers :
Background, Calculation Zones, Luminaires, and Solids.

Objects created when a Dynamic Group is active are automatically
associated to the appropriate Object Layer; i.e. Solids will be associated to
the "Solids " Layer of the System Layers Group .

Example1: a future phase of a project could be placed in a Dynamic Group
, and then removed from the first phase presentation very easily at printing by
turning off the entire Group. At right, the Phase 2 Layer is made
Uneditable.

 

Static Groups are those where Layers can be clustered in a logical
fashion. Layers can be associated to Static Groups and controlled
collectively. Any of the four Object types can be created on a layer and may
then be part of a Static Group.

Example2: in a conference room, the Background and Solid Objects for
the "meeting" and "audiovisual" schemes would be the same and could be
created on the System Layers . Different lighting systems (and possibly
different Calculation Zones) could then be created on different Layers and
made visible individually in the Print Editor to clearly illustrate the lighting in
both schemes.

 

Note that in the two above examples that it is possible to achieve the same or similar results using  Static Groups, Dynamic Groups, and Layers in many different ways. Layer
Groups are provided to allow the user to segment a project in the way that is most logical for a project or is favored by the user.

javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


When CAD files are Imported, Visual automatically creates a Static Group
and all Background Objects will be placed on Layers just as they are in
the CAD file otherwise.

The Static Group will have the name of the CAD file.

Layer Color is set to By Entity to then further preserve the look of the file
as it was last saved in the creating program.

Note that some Layers may be set to Inactive based on the Layer State in
the creating program.

 

Layers can be associated to a Static Group by clicking the Layer name to
make it active and then editing the Classification Properties at the bottom
of the Layer Manager to assign it to the desired Group. The process is
undone by assigning the Layer to the "None" Group.

Layers can also be converted to a Dynamic Group such that all Objects
on the selected Layer will be separated into the four Visual Object types.

 

The use of Static and Dynamic Groups is largely one of user preference in that to a large degree either can be used to achieve an efficient design process, clear lighting model construction,
and clear presentation.
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4.3.5 Manager
The Layer Manager is located in the Sidebar and synonymous with the Layers tab. The Layer Manager shows System Layers and user-defined Layers and allows control of Layer
behavior to provide lighting model organization based on what is appropriate for a project or useful for a user.

If it is not visible, the Layer Manager (Sidebar with Layers tab focus) can be
shown by clicking in one of two places:

- Home tab, Tools panel, Layers sub-menu, Layer Manager

- Tools tab, Options panel, Windows sub-menu, Layer Manager

 

After clicking Group and Layer names, Properties can be edited in the Properties
panel at the bottom of the Layer Manager.

The Layer Manager also contains a toolbar at the top with several buttons to add
and manipulate Layers and Groups.

 

To make a Layer or Group active, and therefore have new Objects associated with
it, double-click the Layer or Group name. Alternately, right-click and select "Active
Layer" from the menu; see information below.

The active Layer or Group is signified by the green icon next to the name. This is
separate from the yellow highlight.

Layers that are part of a Dynamic Group cannot be made active; the Dynamic
Group is what is active and Visual places Objects on the appropriate Object Layer
as they are created. Conversely, a Static Group cannot be made active; Layers that
are part of a Static Group are made active.

 

 

A New Group can be created to organize Layers. The Group type can be selected
as Static or Dynamic in the Properties panel at the bottom of the Layer Manager
. See Layer Groups for more information.
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Layers can be created by clicking the New Layer button at the top of the Layer
Manager. Visual creates the new Layer temporarily and populates the Properties
panel at the bottom of the Layer Manager with the preliminary name "New Layer".
Focus is placed on this preliminary name so it can be easily renamed to something
more meaningful to the current project.

 

Layers can be associated to a Static Group by clicking the Layer name to make it
active and then editing the Classification Properties at the bottom of the Layer
Manager to assign it to the desired Group. The process is undone by assigning the
Layer to the "None" Group.

Layers can also be converted to a Dynamic Group such that all Objects on the
selected Layer will be separated into the four Visual Object types.

 

To Copy a Layer or Group, select the desired items  and click the Copy button at
the top of the Layer Manager.

 

To Delete a Layer or Group, select the desired items and click the Delete button at
the top of the Layer Manager.

Visual presents a dialog to determine if the deleted objects are to be removed or kept
after the Layer is Deleted. Delete Layers Only will move the associated Objects
to the appropriate Layers in the System Layers Group (i.e. Luminaires are
placed on the Luminaires System Layer, etc.). Alternately, Delete Layers and
Entities removes all entities on the Deleted Layer and the selected Layer.

 

Display of Layer Groups can be compacted by pressing the Collapse button in the
upper right corner of the Layers tab to then only show Layer Group names. After
the button is pressed it changes to the Expand button and will be highlighted in
yellow. Pressing the Expand button reverts to the original state of showing all Layer
names.

Groups can also Collapse and Expand by clicking (alternately) on the "-" and "+"
next to the Group name.
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Right-clicking a Layer name will pop-up a menu showing multiple command
shortcuts:

Left-clicking a choice operates on the selected Layer. Active Layer changes the
Layer on which the right-click was initiated to the current Layer.

For more information on these and other Layer commands, see Layers Tools.

 

 

file:///C:/Users/Eric/AppData/Roaming/verychmzip/Chapter_4_New_Features/Layers/4.3.6_Tools.htm


4.3.6 Tools
Visual includes several Layers Tools to aid in working with Layers in complex projects. The Layers sub-menu button is located on the Home tab of the Ribbonbar, although the commands
are also found in the Layer Manager (Layers tab of the Sidebar).

Layers Tools are found in the submenu initiated with the Layers button on the
Tools tab of the Ribbonbar.

 

The Layer Manager command in the sub-menu activates the Layer Manager in
the Sidebar (the Layers tab) if it has been closed or switches to that tab in the
Sidebar if it is not currently active. See Layers or more information.

 

Identify Layers allows for selection of an object to determine the Layer on which it
resides. Select an object and then right-click to end the command. Visual will highlight
the Layer in the Layer Manager. If objects on multiple Layers are selected, Visual
will identify all Layers.

 

Isolate Layers allows for the selection of a on object, and the Layer on which it
resides will be left Visible while all other Layers will be made Invisible. Unisolate
Layers makes all Layers Visible.

 

Deactivate Layers allows for selection of an object, and the Layer on which the
object resides will be made Inactive. "Inactive" in this context is a coupling of both the
Inactive Calculation State and being Invisible.

 

Purge Empty Layers removes all Layers that have no associated objects. This is
particularly useful after a CAD Import to allow for more clarity since CAD software
add-ins can be elaborate. This operation cannot be undone, so Visual displays a
warning message as a reminder.
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4.4 Proper es
The Properties tab is located in the Sidebar. The tab is dynamic in that the content will change depending on which of the four object types is chosen in the selection process.

Object properties can be accessed and modified by executing the Properties command in one of four ways:

1) Left-click the Properties button in the Tools panel on the Home tab of the
Ribbonbar.

 

2) Select the menu item from the Windows sub-menu in the Options panel of the
Tools tab in the Ribbonbar. Note that the letter "P" next to the command indicates
that the hotkey for the command is the "P" key.

 

3) Left-click the Properties button is located on the Properties tab of the Sidebar.

 

 

4) The Visual hotkey "P" can be pressed on the keyboard to execute the command.  

Executing the Properties command causes Visual to display the Properties tab in
the Ribbonbar discussed in the next sub-section.

 

After Properties have been suitably modified, click the right mouse button to end the  
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command and apply parameter modifications.

 



4.4.1 Ribbonbar Proper es Tab
Properties of various entities are modified in the Sidebar as described in subsequent sections. Selecting objects to modify is done in the Properties tab in the Ribbonbar after the command
has been executed.

Executing the Properties command causes Visual to display the Properties tab in
the Ribbonbar. The tab includes a variety of ways to aid in selecting objects.

 

The Properties tab will include the Selection panel to assist in selecting objects for
Modify tab commands. Visual defaults to adding clicked objects to the selection set,
signified by the Add Selection button being highlighted in yellow.

 

The Properties tab will include the Object Filters panel to assist in selecting
objects for Modify tab commands and other times when objection selection is
required; e.g. specifying a surface on which to place a Calculation Zone. A
checkbox is present for each of the four object types. Unchecking a box tells Visual to
ignore objects of that type when selecting objects.

 

Placing a check in the Surface Color checkbox allows a Color to be chosen. When
selecting Solid objects with one of the various methods described here, Visual will
then filter the objects to include only those having the color specified. This selection
refinement (filter) works only with Solid objects.

 

Selection Modes allows for fine-tuning of how objects are selected.

Single Selection - Left-clicking an object makes that object the only member of the
selection set.

Multiple Selection - Each left-click of an object adds to the selection set. See
Selecting Objects for information on selecting objects that are "stacked".

Turning Surface Selection on by checking the box will select individual surfaces that
are part of Rooms, Structures, or Grouped Solid objects.

 

See Display Modes and Basic Viewing for information on the View panel.  
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Note that many selection and filtering methods can be combined to quickly select desired objects. Discussion of the use the Properties tab in the Sidebar for each of the four object types
follows in this chapter.
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4.4.2 Background Proper es
Background properties are shown in the Sidebar when the Properties command is active and Background objects are selected.

To activate the Properties command, click the Properties button on the Home tab
of the Ribbon Bar or in the Sidebar, or press the "P" hotkey. When a
Background object is selected, Visual displays the properties for that object in the
Sidebar.

 

For Polyline objects Visual displays the following panels:   

The Layer panel indicating on which layer the object resides. The layer may be
changed by clicking the drop-down menu arrow on the right. "System Layers" is the
default and is in fact a Layer Group, which indicates the object is on the
Background layer of the System Layers group. See Layers for more information.

 

The Status panel contains a Visible menu that allows control of individual objects.
Selecting "Yes" means the object(s) will be visible. Selecting "No" means the object(s)
will not be visible. "ByLayer" indicates that control of object visibility is controlled by
selections made in the Layer Manager for Editability.

Once an object has been made not visible with this dialog, the only way to get access
to the object is through the Design Manager where the object can be selected and
made visible again, for example.

 

For Polyline objects, Visual displays the Polyline panel, which contains:

Line Color showing the currently selected Color and allows for modification with the
Color dialog.

Line Weight showing the current width in pixels and allows for modification with the
drop-down menu and the associated text box.

Line Style showing the currently selected style and the menu allows selection of one
of the 9 styles.

Length is the sum of all segments in feet or meters.

Since Background objects cannot be named, a reference number for identification
is displayed in square brackets in the panel title. This reference number is indexed for
Polylines and Polygons together.

 

For Polygon objects, Visual displays the Polygon panel, which  adds the following:

Area is shown in square feet or square meters inside the polygonal solid boundary.
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Center is the X,Y,Z triplet coordinates for the centroid of the Polygon. See
http://en.wikipedia.org/wiki/Centroid for more information.

Normal is the direction the perpendicular to the surface points in a unit vector. i.e.
(0,0,1) would indicate the front surface is in the positive Z direction. See
http://en.wikipedia.org/wiki/Surface_normal for more information.

The Coordinates panel shows the coordinates of each vertex  in  X,Y,Z triplets.
These are not editable.

 

Multiple objects can be selected and modified. Properties that do not have the same
value will have an ellipsis entry indicating multiple values. The ellipsis can be clicked
and parameters modified as normal, thus setting that value to all objects; for example,
color or layer.

 

After Properties have been suitably modified, click the right mouse button to end the
command and apply parameter modifications.

 

Drop-down menus in the Properties tab allow for parameter selection just as in the commands that create objects. Reference specific commands for detailed information on parameters.

javascript:TextPopup(this)
javascript:TextPopup(this)
http://en.wikipedia.org/wiki/Centroid
javascript:TextPopup(this)
http://en.wikipedia.org/wiki/Surface_normal
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)
javascript:TextPopup(this)


4.4.3 Calcula on Zone Proper es
Calculation Zone properties are shown in the Sidebar when the Properties command is active and Calculation Zone objects are selected.

To activate the Properties command, click the Properties button on the Home tab
of the Ribbon Bar or in the Sidebar, or press the "P" hotkey. When a Calculation
Zone object is selected, Visual displays the properties for that object in the Sidebar.

 

For Calculation Zone objects, Visual displays:   

The Status panel contains Calculate and Visible menus that allow control of
individual objects. Selecting "Yes" means the object(s) will be used in calculations or
will be visible. Selecting "No" means the object(s) will not be used in calculations and
will not be visible. "ByLayer" indicates that control of object visibility and use in
calculations is controlled by selections made in the Layer Manager for Editability and
Calculation State.

Once an object has been made not visible with this dialog, the only way to get access
to the object is through the Design Manager where the object can be selected and
made visible again, for example.

 

The Layer panel indicating on which layer the object resides. The layer may be
changed by clicking the drop-down menu arrow on the right. "System Layers" is the
default and is in fact a Layer Group, which indicates the object is on the
Background layer of the System Layers group. See Layers for more information.

 

The General panel contains:

Name is the user-specified name or the Visual default.

Area is shown in square feet or square meters inside the polygonal solid boundary.

Center is the X,Y,Z triplet coordinates for the geometric center of the Polygon.

Point Spacing shows the spacing of points in X and Y axes respectively and allows
modification with drop-down menus and the associated text boxes.

 

The Calculation Points panel contains:

Color shows the currently selected Color and allows for modification with the Color
dialog.
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Lower Limit defines the Color of the value highlight and allows specification of the
type of highlight. Minimum indicates only the lowest value is highlighted. Choosing a
value from the drop-down or typing a value will highlight values less than or equal to
that value.

Upper Limit defines the Color of the value highlight and allows specification of the
type of highlight. Maximum indicates only the highest value is highlighted. Choosing a
value from the drop-down or typing a value will highlight values greater than or equal to
that value.

Decimal indicates how many digits are displayed.

Point Style illustrates the selected symbol used to indicate each calculation point
and allows modification to one of 5 choices.

The Display panel contains:

Calculation Points is a checkbox indicating if points are shown or not.

Contours is a checkbox indicating if the iso-illuminance contours are displayed or not
on a per-zone basis. Once Contours are turned on in the Calculations tab of the
Ribbonbar, this allows for individual zone contours to be displayed or not.

Shaded is a checkbox indicating if pseudo-color shading is turned on or off.

 

The Calculation panel contains:

Type is a drop-down menu for selection of one of the 7 ways in which Visual handles
meter orientation.

Measurement is a drop-down menu allowing selection of one of 4 calculation
units/methods.

Reflectance is a text box for specification of the necessary parameter for
non-Illuminance calculations.

See Calculation for more information.

 

The Calculation Parameters panel contains:

Normal is the direction the perpendicular to the surface points in a unit vector. i.e.
(0,0,1) would indicate the plane of the Calculation Zone is in the positive Z direction.

Orientation indicates the rotation of the "meter" associated to each point of the
Calculation Zone with respect to the 0° X-axis.

Tilt is the angle of inclination of the "meter" associated to the Calculation Zone with
0° being straight up, 90° being at the horizon, and 180° being straight down.

 

When modifying a Calculation Zone created with the TV option, Visual displays the
location of the camera for modification. See Calculation Types
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The Flip button rotates the surface Normal 180°. When using the Calculation
Zone Surface command, Visual places the grid on the "front" face of the solid.
Depending on the order in which the vertices were chosen, the result of this command
may not place the grid on the desired side. Therefore, the Flip button would make the
other side of the solid the "front" and Visual would place the grid on the opposite side.

 

Multiple objects can be selected and modified. Properties that do not have the same
value will have an ellipsis entry indicating multiple values. The ellipsis can be clicked
and parameters modified as normal, thus setting that value to all objects; for example,
color or layer.

 

After Properties have been suitably modified, click the right mouse button to end the
command and apply parameter modifications.

 

Drop-down menus in the Properties tab allow for parameter selection just as in the commands that create objects. Reference specific commands for detailed information on parameters.
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4.4.4 Luminaire Proper es
Luminaire properties are shown in the Sidebar when the Properties command is active and Luminaire objects are selected.

To activate the Properties command, click the Properties button on the Home tab
of the Ribbon Bar or in the Sidebar, or press the "P" hotkey. When a Luminaire
object is selected, Visual displays the properties for that object in the Sidebar.

 

For Luminaire objects, Visual displays the following panels:   

The Layer panel indicating on which layer the object resides. The layer may be
changed by clicking the drop-down menu arrow on the right. "System Layers" is the
default and is in fact a Layer Group, which indicates the object is on the
Background layer of the System Layers group. See Layers for more information.

 

The Status panel contains Calculate and Visible menus that allow control of
individual objects. Selecting "Yes" means the object(s) will be used in calculations or
will be visible. Selecting "No" means the object(s) will not be used in calculations and
will not be visible. "ByLayer" indicates that control of object visibility and use in
calculations is controlled by selections made in the Layer Manager for Editability and
Calculation State.

Once an object has been made not visible with this dialog, the only way to get access
to the object is through the Design Manager where the object can be selected and
made visible again, for example.

 

The Luminaire Type panel contains:

Luminaire Selector, which is a reduced drop-down version of the Luminaire
Schedule. showing Luminaire Label and Count. The drop-down menu shows the
truncated schedule Label, Count, and Catalog Number.

Candela Distribution showing the shape of the luminaire output with the name of
the photometric file below the polar plot.

 

The Position panel contains:

Aim Point is an editable X,Y,Z triplet indicating where the Luminaire is aimed.
Unless the Luminaire was inserted with Place & Aim, Visual assumes the aim point
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to be in the Z=0 plane.

Insertion Point is an editable X,Y,Z triplet indicating where the Luminaire is placed.
Unless the Luminaire was inserted with Place & Aim, Visual assumes the
placement to be in the Z=0 plane.

Mounting Height  of a Luminaire is set when a Luminaire is placed and can be
modified to any value to suit the design intent.

Orientation indicates the rotation of the Luminaire with respect to the 0° X-axis.
See 3.2 The Luminaire Editor for more information.

Tilt is the angle of inclination with 0° being straight down, 90° being at the horizon, and
180° being straight up.

The Display panel contains:

Aim Line is a checkbox that turns on or off the display of the line from the Luminaire
to the Aim Point. This can be very useful to illustrate where luminaires are aimed for
certain project types like facade lighting.

Photometric Web is a check box that turns on or off the display of a pseudo-scaled
3-D mesh illustrating the shape of the candela distribution for the selected Luminaire.

Label Location is a drop-down menu with 5 location choices to avoid possible
overlap of Labels when displayed in certain situations.

 

Multiple objects can be selected and modified. Properties that do not have the same
value will have an ellipsis entry indicating multiple values. The ellipsis can be clicked
and parameters modified as normal, thus setting that value to all objects; for example,
color or layer.

 

After Properties have been suitably modified, click the right mouse button to end the
command and apply parameter modifications.

 

Drop-down menus in the Properties tab allow for parameter selection just as in the commands that create objects. Reference specific commands for detailed information on parameters.
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4.4.5 Solid Proper es
Solid properties are shown in the Sidebar when the Properties command is active and Solid objects are selected.

To activate the Properties command, click the Properties button on the Home tab
of the Ribbon Bar or in the Sidebar, or press the "P" hotkey. When a Solid object
is selected, Visual displays the properties for that object in the Sidebar.

 

For Solid objects, Visual displays the following panels:   

The Layer panel indicating on which layer the object resides. The layer may be
changed by clicking the drop-down menu arrow on the right. "System Layers" is the
default and is in fact a Layer Group, which indicates the object is on the
Background layer of the System Layers group. See Layers Tab for more
information.

 

The Status panel contains Calculate and Visible menus that allow control of
individual objects. Selecting "Yes" means the object(s) will be used in calculations or
will be visible. Selecting "No" means the object(s) will not be used in calculations and
will not be visible. "ByLayer" indicates that control of object visibility and use in
calculations is controlled by selections made in the Layer Manager for Editability and
Calculation State.

Once an object has been made not visible with this dialog, the only way to get access
to the object is through the Design Manager where the object can be selected and
made visible again, for example.

 

The General panel contains:

Name is the user-specified name or the Visual default.

Area is shown in square feet or square meters inside the polygonal solid boundary.

Normal is the direction the perpendicular to the surface points in a unit vector. i.e.
(0,0,1) would indicate the front surface is in the positive-Z direction. The Flip button
orients the Surface Normal 180° from its current position and thus changes the
"front" to the "back".

Reflectance is the numerical value and associated color of the solid.

Transmittance is set to 0% and diffuse by default when creating an object.
Transmittance can be modified to be higher and/or Transparent. Diffuse
Transmittance is like an opal acrylic where a clear image cannot be seen through
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the material.

The Render panel allows for one or both sides of a Solid Object to be hidden in
Rendered Display Mode. Placing a check in the box indicates that selection will be
hidden.

 

The Coordinates panel shows all vertex coordinates in  X,Y,Z triplets and is not
editable.

 

The Flip button rotates the surface Normal 180°. When using the Calculation
Zone Surface command, Visual places the grid on the "front" face of the solid.
Depending on the order in which the vertices were chosen, the result of this command
may not place the grid on the desired side. Therefore, the Flip button would make the
other side of the solid the "front" and Visual would place the grid on the opposite side.

 

The Link button connects the solid Reflectance to the Color. When Color and
Reflectance are Linked, Visual will adjust the Reflectance value based on the
chosen Color. In complex designs not involving Rendering, it may be advantageous
to color objects differently in the model for identification without impacting the
calculations.

 

When a Room or Structure is selected, Visual displays the associated Solids in
the Surfaces section of the Sidebar. Selecting one of the Surfaces in the Sidebar
populates the General and Coordinates sections with the associated information.

See Ribbonbar Properties Tab for information on how Single Selection and
Multiple Selection impact selection of Grouped objects.

 

Multiple objects can be selected and modified. Properties that do not have the same
value will have an ellipsis entry indicating multiple values. The ellipsis can be clicked
and parameters modified as normal, thus setting that value to all objects; for example,
color or layer.

 

After Properties have been suitably modified, click the right mouse button to end the
command and apply parameter modifications.
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Drop-down menus in the Properties tab allow for parameter selection just as in the commands that create objects. Reference specific commands for detailed information on parameters.
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